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Introduction

Ce document décrit comment mettre à niveau une image logicielle sur les appareils Cisco ASA 
5500 avec Cisco Adaptive Security Device Manager.

Conditions préalables

Exigences

Aucune exigence spécifique n'est associée à ce document.

Composants utilisés

Les informations contenues dans ce document sont basées sur les versions de matériel et de 
logiciel suivantes :

Cisco ASA 5500 et ASA 5500-X 9.1(2) et versions ultérieures•

Cisco ASDM 7.1 et ultérieures•



The information in this document was created from the devices in a specific lab environment. All of 
the devices used in this document started with a cleared (default) configuration. Si votre réseau 
est en ligne, assurez-vous de bien comprendre l’incidence possible des commandes.

Produits connexes

Cette configuration peut également être utilisée avec le logiciel du dispositif de sécurité Cisco ASA 
5500-X version 9.x.

Conventions

Pour plus d’informations sur les conventions utilisées dans ce document, reportez-vous aux 
Conventions relatives aux conseils techniques Cisco.

Téléchargez le logiciel

Pour télécharger la version requise des images du logiciel ASA et des images du logiciel ASDM, 
utilisez les liens suivants :

Téléchargement de la version du logiciel Cisco ASA (clients enregistrés uniquement)•

Téléchargement de la version du logiciel Cisco ASDM (clients enregistrés uniquement)•

Remarque : des informations d'identification valides sont nécessaires pour télécharger ce 
logiciel à partir de Cisco.com.

Compatibilité entre ASA et ASDM

Le lien affiché est mis à jour avec la compatibilité et la version ASDM recommandée par Cisco 
pour chaque version d'ASA.

Compatibilité ASA et ASDM

Chemin de mise à niveau ASA

Le lien affiché fournit le chemin de mise à niveau pour ASA. Certaines versions nécessitent une 
mise à niveau intermédiaire avant de pouvoir effectuer la mise à niveau vers la dernière version.

Chemin de mise à niveau ASA

Mettre à niveau une image logicielle ASA avec l'utilisation 
d'ASDM 7.x

Suivez ces étapes pour mettre à niveau une image logicielle sur l'ASA 5500 à l'aide de l'ASDM.

https://www.cisco.com/c/fr_ca/support/docs/dial-access/asynchronous-connections/17016-techtip-conventions.html
https://software.cisco.com/download/home/278875415
https://software.cisco.com/download/home/279513399/type/280775064/release/7.17.1.155
/content/en/us/td/docs/security/asa/compatibility/asamatrx.html#pgfId-121785
/content/en/us/td/docs/security/asa/upgrade/asa-upgrade/planning.html#id_58680


1. Lorsque ASA est en mode de contexte unique, sélectionnez Tools > Upgrade Software from Local Computer... 
dans la fenêtre d'accueil de l'ASDM.

 

Lorsque ASA est exécuté en mode de contexte multiple, le Upgrade Software from Local Computer option 
de la Tools n'est disponible que dans le contexte Système.

 
2. Sélectionnez ASA comme type d'image à télécharger dans la liste déroulante.

 



 
3. Cliquez sur Browse Local Files... ou tapez le chemin dans la zone Local File Path pour spécifier 
l'emplacement de l'image logicielle sur le PC. 
 
4. Cliquez sur Parcourir Flash... 
 
5. Une boîte de dialogue Parcourir Flash s'affiche, avec le nom de fichier entré automatiquement. 
Si le nom de fichier n'apparaît pas, saisissez-le manuellement dans le champ File Name champ. 
Cliquer OK lorsque vous avez terminé. 
 

 
 
6. Une fois que les noms des fichiers locaux et distants sont spécifiés, cliquez sur Upload Image.

 



 
 
7. Une fenêtre d'état s'affiche pendant que l'ASDM écrit l'image dans la mémoire flash. Une fois 
terminé, une fenêtre d'informations s'affiche pour indiquer que le téléchargement a réussi et pour 
vous demander si l'image doit être définie comme image de démarrage. Sélectionner Yes.



Cliquer OK dans la boîte de dialogue Informations, puis cliquez sur Close dans la boîte de dialogue 
Télécharger l'image à partir du PC local. 

8. Choisissez Tools > System Reload dans la fenêtre Accueil pour recharger le périphérique.

 
 

Une nouvelle fenêtre s'affiche pour vérifier les détails du rechargement. Sélectionner Save the running 

configuration at the time of reload puis choisissez une heure de rechargement. Les choix de temps incluent 
:

Now — Redémarrer le périphérique immédiatement.•
Delay By — Spécifier dans combien de minutes ou d'heures à partir de maintenant le 
périphérique doit être rechargé.

•

Schedule at — Spécifier une heure et une date pour recharger le périphérique.•

 
En outre, spécifiez si le périphérique doit forcer un rechargement immédiatement en cas d'échec 
d'un rechargement planifié. Chèque On Reload failure, force an immediate reload after puis spécifiez un temps 
d'attente maximal. Il s'agit de la durée pendant laquelle l'appliance de sécurité attend d'avertir les 
autres sous-systèmes avant un arrêt ou un redémarrage. Une fois ce temps écoulé, un 
arrêt/redémarrage rapide (forcé) se produit. Cliquer Schedule Reload.

 



 
Une fois le rechargement en cours, un Reload Status s'affiche pour indiquer qu'un rechargement est en 
cours. Une option permettant de quitter ASDM est également fournie. 
 

Remarque : redémarrez ASDM après le rechargement de l'ASA.

 



Mettez à niveau l'image ASDM avec l'utilisation d'ASDM 7.x.

Effectuez ces étapes pour mettre à niveau une image logicielle sur l'ASA 5500 avec celle de 
l'ASDM.

1. Sélectionnez Tools > Upgrade Software from Local Computer... a partir des versions Home de l'ASDM.

 



 
 
2. Sélectionnez ASDM comme type d'image à télécharger à partir de la liste déroulante.

 
3. Cliquez sur Browse Local Files...  ou tapez le chemin dans la zone Local File Path pour spécifier 
l'emplacement de l'image logicielle sur le PC.

Cliquer Browse Flash....

A Browse Flash s'affiche avec le nom de fichier saisi automatiquement. Si le nom de fichier ne 
s'affiche pas, saisissez-le manuellement dans le champ File Name champ. Cliquer OK lorsque vous 
avez terminé.



 
4. Cliquez sur OK lorsque l'image est mise à jour avec la nouvelle image.

 
5. Sélectionnez File > Save Running Configuration to Flash a partir des versions Home de l'ASDM.

 



 
Quittez l'ASDM et reconnectez-vous pour gérer l'ASA avec l'image ASDM mise à niveau.

Mettre à niveau l'ASA et l'ASDM par une image Télécharger 
Directement depuis CCO

 
Complétez ces étapes pour mettre à niveau une image ASA et ASDM directement à partir de 
CCO. 
 
1. Sélectionnez Tools > Check for ASA/ASDM Updates... a partir des versions Home de l'ASDM.

 
2. Lorsque l'invite nom d'utilisateur et mot de passe s'affiche, fournissez les informations 



d'identification Cisco.com et cliquez sur Login.

 
 
3. Le Cisco.com Upgrade Wizard s'affiche. Dans la Overview , cliquez sur Next. 
 



 
 
4. Dans la Select Software , vérifiez le logiciel qui doit être mis à niveau. Si ASA et ASDM doivent être 
mis à niveau, cochez les deux options. 
 



 
5. Dans la liste déroulante Version ASA, sélectionnez la version vers laquelle la mise à niveau 
ASA doit être effectuée.



 
6. Dans la liste déroulante Version ASDM, sélectionnez la version vers laquelle la mise à niveau 
ASDM doit être effectuée. Cliquer Next lorsque les versions appropriées ont été sélectionnées.



 
7. Dans la Review Changes , vérifiez les modifications et cliquez sur Next.



 
8. L'installation des images commence et la progression globale peut être vue comme indiqué. 
Une fois terminé, cliquez sur Finish. 
Dans la Results , cochez la case Save configuration and reload device now de l'assistant. Cliquer Finish.



 
9. Le Reload Status s'affiche pendant le rechargement du périphérique.



 
10. Cliquez sur Exit ASDM et reconnectez-vous une fois que le périphérique est activé après le 
rechargement.

Utiliser CLI pour mettre à niveau une image logicielle et une 
image ASDM

Un serveur TFTP est nécessaire pour mettre à niveau ou rétrograder une image logicielle, ainsi 
qu'une image ASDM pour un ASA. Référez-vous à Sélection et utilisation du serveur TFTP pour 
en savoir plus sur la sélection du serveur TFTP.

Les copy tftp flash permet à TFTP de télécharger une image logicielle dans la mémoire flash du pare-
feu. Utilisez copy tftp flash avec un modèle d'appliance de sécurité. L'image téléchargée peut 
maintenant être utilisée lors du prochain redémarrage par une modification de la variable système 
de démarrage pour pointer vers cette image.

Voici le résultat de la commande copy tftp flash commande :

 

https://www.cisco.com/c/fr_ca/support/docs/routers/10000-series-routers/48700-tftp-server.html


copy tftp[:[[//location] [/tftp_pathname]]] [[flash/disk0][:[image | asdm]]]

 

Pour le mode de contexte multiple, effectuez ces étapes dans l'espace d'exécution du système.

Remarque : pour ASA, le mot clé disk0 remplace la mémoire flash dans le copy 
erasecat4000_flash:.

Si la commande est utilisée sans les paramètres optionnels d'emplacement ou de nom de chemin, 
l'emplacement et le nom de fichier sont obtenus de l'utilisateur de manière interactive par une 
série de questions similaires à celles présentées par le logiciel Cisco IOS®. Si un signe deux-
points seulement est saisi, les paramètres sont extraits de la tftp-server paramètres de commande. Si 
d'autres paramètres facultatifs sont fournis, ces valeurs sont utilisées à la place des paramètres 
associés tftp-server paramètre de la commande. Si l'un des paramètres facultatifs, tels qu'un deux-
points et n'importe quoi après, est fourni, la commande s'exécute sans invite pour une entrée 
utilisateur.

L'emplacement est soit une adresse IP, soit un nom qui est converti en adresse IP par le 
mécanisme de résolution de noms de l'appliance de sécurité, qui est actuellement mappé de 
manière statique par le name et names de l'assistant. L'appliance de sécurité doit savoir comment 
accéder à cet emplacement à l'aide des informations de sa table de routage. Ces informations 
sont déterminées par le IP address,les route, ou la RIP de l'assistant. Cela dépend de votre 
configuration.

Le nom de chemin d'accès peut inclure des noms de répertoires en plus du dernier composant 
réel du chemin d'accès au fichier sur le serveur. Le nom de chemin d'accès ne peut pas contenir 
d'espaces. Si un nom de répertoire comporte des espaces, définissez-le sur le répertoire du 
serveur TFTP au lieu de copy tftp flash erasecat4000_flash:. Et si votre serveur TFTP est configuré 
pour pointer vers un répertoire du système à partir duquel vous téléchargez l'image, utilisez 
uniquement l'adresse IP du système et le nom de fichier de l'image. Le serveur TFTP reçoit 
commande et détermine l'emplacement de fichier réel à partir de ses informations de répertoire 
racine. Le serveur télécharge alors l'image TFTP sur le dispositif de sécurité.

Ces commandes sont nécessaires pour mettre à niveau l'image logicielle, ainsi que l'image 
ASDM, et la transformer en image de démarrage lors du prochain rechargement.

 
<#root>

ASA

#copy tftp [[flash:/disk0:][software image name/asdm image name]]

 

!--- Command to set an image as bootup or specify the 

!--- ASDM image file.

 
 
ASA(config)



#boot system [flash:/disk0:]/[software image name]

 

!--- Save active configuration to the Flash.

 
ASA

#write memory

 

!--- Reboot the security appliance and load 

!--- with the new boot image as per the configuration file.

 
ASA

#reload 

 

Exemple :

 
<#root>

ASA-5512# copy tftp: disk0: 
 
Address or name of remote host []? 172.16.31.1 
Source filename []? asa916-smp-k8.bin 
Destination filename [asa916-smp-k8.bin]? 
Accessing tftp://172.16.31.1/asa916-smp-k8.bin...!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
Writing file disk0:/asa916-smp-k8.bin... 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
38043648 bytes copied in 32.290 secs (1188864 bytes/sec) 
 
ASA-5512# sh disk0 
--#--  --length--  -----date/time------  path 
 

 191  38191104    Nov 21 2014 21:07:48  asa912-smp-k8.bin 

  192  17906032    Apr 08 2015 22:33:44  asdm-713.bin 

  193  26350916    Apr 09 2015 06:28:20  asdm-741.bin 

  194  38043648    May 10 2015 02:14:06  asa916-smp-k8.bin 

 

4118732800 bytes total (3556712448 bytes free) 
 
 

!--- Command to set "asa916-smp-k8.bin" as the boot image.

 
ASA-5512(config)

# boot system disk0:/asa916-smp-k8.bin

 



!--- Command to set "asdm-741.bin" as the ASDM image.

 
ASA-5512(config)

# asdm image disk0:/asdm-741.bin

ASA-5512

# write memory

ASA-5512

# reload 

 

Remarque : lorsque vous essayez de mettre à niveau l'image sur l'ASA à partir d'un serveur 
FTP, utilisez la copy ftp flash erasecat4000_flash:. Cette commande permet de spécifier des 
paramètres, tels que l'adresse IP distante et le nom du fichier source. Cette procédure est 
similaire à la procédure TFTP. Cependant, une limitation est que vous ne pouvez pas 
modifier l'interface IP/source distante (comme vous pouvez le faire avec TFTP). En mode 
TFTP, les options spécifiées avec la commande tftp-server peut être tirée et exécutée. Mais 
avec FTP, cette option n'existe pas. Par défaut, l'interface source est toujours l'interface 
externe, qui ne peut pas être modifiée. En d'autres termes, le serveur FTP est accessible 
depuis l'interface externe.

Vérifier

Utilisez cette section pour confirmer que la mise à niveau logicielle a réussi.

Cisco CLI Analyzer (clients enregistrés uniquement) prend en charge show de l'assistant. Utilisez 
Cisco CLI Analyzer pour afficher une analyse du show résultat de la commande.

Après le rechargement de l'ASA et la reconnexion réussie à l'ASDM, vérifiez la version de l'image 
qui s'exécute sur le périphérique. Consultez la General de l'onglet Home pour obtenir ces informations.

https://cway.cisco.com/cli
http://tools.cisco.com/RPF/register/register.do


Les commandes CLI suivantes permettent de vérifier la mise à niveau :

Show version : affiche l'image actuelle avec laquelle l'ASA est amorcé.1. 
Show bootvar : indique la priorité de l'image à utiliser après le rechargement.2. 
Show asdmimage : affiche l'image ASDM actuelle utilisée par l'ASA.3. 

Dépannage

Il n’y a actuellement aucune information spécifique disponible pour dépanner cette configuration.

Informations connexes

notes de version•
Nouvelles fonctionnalités de Cisco ASA par version•
Compatibilité Cisco ASA•
Planification de votre mise à niveau•
Mettre à niveau une configuration de basculement actif/veille•

https://www.cisco.com/c/fr_ca/support/security/asa-5500-series-next-generation-firewalls/products-release-notes-list.html
/content/en/us/td/docs/security/asa/roadmap/asa_new_features.html
/content/en/us/td/docs/security/asa/compatibility/asamatrx.html
/content/en/us/td/docs/security/asa/upgrade/asa-upgrade/planning.html
/content/en/us/td/docs/security/asa/upgrade/asa-upgrade/asa-appliance-asav.html#concept_xxv_yvn_kkb


À propos de cette traduction
Cisco a traduit ce document en traduction automatisée vérifiée par une personne dans le
cadre d’un service mondial permettant à nos utilisateurs d’obtenir le contenu d’assistance
dans leur propre langue.
 
Il convient cependant de noter que même la meilleure traduction automatisée ne sera pas
aussi précise que celle fournie par un traducteur professionnel. 


